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I.  The Consulting Situation  
 
Organization 
The East Liberty Presbyterian Church (ELPC) is located at 116 S. Highland Avenue, Pittsburgh, PA.  The 
Hope Academy of Music and the Arts is located within the church and operates under the mission 
“Bringing hope through the arts”.  The church operates under the mission statement “Reaching Up, 
Reaching Out, Reaching You.”  Every department within the church, including the Hope Academy, 
functions under these guiding principles.  The three phrases stress the church’s goals to communicate with 
God, reach out to the community, and provide each member the opportunity to grow. 

The church is a large organization with a specific hierarchy.  Religious rules of the Presbyterian Church 
dictate that the operations of the church are governed by the “Book of Order”, which is an official 
document of the Presbyterian Church (USA).  The Congregation of ELPC elects members to the Session, 
which governs all committees: 

• Budget and Finance/Stewardship 
• Membership and Growth 
• Communications and Special Events 
• Personnel 
• Spiritual Life 
• Property 
• Christian Education 
• Strategic Planning 
• Community Mission 
• Justice and Global Concerns 
• Worship, Music, and the Arts 
• Community Development 
• Board of Deacons 
• Officer Nominating 

 
The Hope Academy, directed by Ms. Addlespurger, falls under the “Worship, Music, and the Arts” 
committee.  The church website (located at http://www.cathedralofhope.org) is supervised by Ms. Toth, 
who is the Communications Specialist and staff liaison to the Communications and Special Events 
committee.   
 
The church has approximately 75 full/part time employees, and up to over 100 volunteers at any given 
time as well as several contract workers, such as musicians and artists.  The Hope Academy has two 
employees but other staff members from the church contribute to the programs.  The church is composed 
of about 600 Members and Friends and it is estimated that about a thousand people come through the 
doors of the church every week.  The Hope Academy enrolls about 150 students per term.  
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Programs 
The church has several regular worship services, including Good Samaritan, Morning Glory, and 
Sanctuary Sunday services, and a Wednesday Taizé service.  The Labyrinth experience is available on 
Mondays and Wednesdays. 

The church provides a great deal of support for the community. The church departments run various 
programs out of the church as well.  For example, on several days each week, Christian Education 
provides Bible classes and discussion groups for people of all ages, and the Family Enrichment Center 
provides family based programming and activities, such as stress management, life skills, chess, mime, 
African drumming, arts and crafts, videos, and recreation.  The church also serves as a home for the 
Samaritan Shelter for men, the Food Pantry, a soup kitchen, tutoring program, and several women’s 
groups.  There are many musical opportunities at ELPC since there are several choirs, a hand bell choir, 
and Taizé musicians.  The church also promotes community fellowship through picnics, community 
dinners, and family fun nights.   

The Hope Academy provides classes in dance, music, theater, writing and visual arts to young people.  
Local arts and cultural organizations, such as the Pittsburgh Ballet Theater, Xpressions Contemporary 
Dance Company and Prime Stage Theater, work in partnership with Hope Academy.  The students are 
given opportunities to perform and display their work throughout each term.   

Staff 
Ms. Toth is the direct liaison between the church and the webmaster, Jeffry Johnson, and she is ELPC’s 
Communication Specialist.  Ms. Addlespurger is the director of the Hope Academy and oversees all of the 
programs that occur there.  She reports to the Worship, Music, & the Arts committee and its director, the 
Reverend Dr. J. Richard Szeremany.  All office staff members have access to networked computers and 
are provided with email addresses in the coh.net domain.   

Technical Environment 
Most of the approximately 25 networked computers at ELPC have Microsoft Outlook 2000 installed.  In 
addition to this, the Hope Academy uses two of ELPC’s networked personal computers as well as a CD 
burner.  Hope Academy uses Microsoft Access and Excel to do payroll and keep track of students. 

Technology Management 
Computers are used in many ways at both the church and the Academy.  They are used to manage funds, 
mailing lists, publications and communications. The Hope Academy uses these programs as well as an 
Access database to track student records.  Everything that goes on the ELPC website has to be approved 
by Ms. Toth and submitted to Mr. Johnson.   

Technology Planning 
A separate budget line item for website maintenance is managed by the Communications committee.  
This budget is currently undergoing some revisions.  Ms. Addlespurger is in charge of all technology 
planning for Hope Academy.   

Internal & External Communications 
Both the church and the Academy use the same website (www.cathedralofhope.org), and they both send 
various printed publications.  The church is in the process of a major redesign of the web page.  Hope 
Academy is also looking into a redesign of their section of the web page, which is on the ELPC site.  All 
office staff members have email accounts, while other staff, such as security, receive information from 
their supervisors. Employees maintain their own email lists, since the Automated Church System (ACS) 
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software is not used in conjunction with email. Ms. Addlespurger maintains her own email lists for the 
Hope Academy.   

Both the church and Academy use various sources for providing information to the community.  These 
include newsletters, the websites, email, pamphlets, and brochures.  

Information Management 
A wide variety of information is critical to the church including financial information, church/community 
needs, donor information, and space reservations.  The Hope Academy needs similar information, 
especially financial, in order to report it to their funders. Information between staff members is often 
shared over the network drive or by email.   

Task 1: ELPC Email Usage  
Staff members do not receive formal on-site training to learn how to utilize commonly used software 
packages at ELPC, although ELPC will pay for staff members to take outside training courses which will 
help them in their day to day job performance.  One common issue that all staff members deal with on a 
daily basis is email usage since it is heavily used for both internal and external communication.  By 
improving email usage, ELPC staff will be able to fulfill their mission because they are able to focus 
more on their duties as church employees (“Reaching Up”), educate themselves (“Reaching You”), and 
communicate more effectively with the community (“Reaching Out”). 

Specific Problems 
• Some staff members had never used email outside of work at ELPC. 
• Staff members spent more time than necessary seeking answers to basic questions concerning 

email. 
• Staff members did not fully utilize the capability of Outlook 2000. 

 
Approach: Creating quick desk reference sheets for ELPC staff 
In this approach, the consultant worked with Ms. Toth to create quick desk reference sheets outlining the 
main points and functions of email usage at ELPC and addressing issues of email policy and etiquette. 
Ms. Toth and the consultant worked to adapt some existing tutorials for Microsoft Outlook 2000 for use 
as reference sheets.  Ms. Toth and the consultant also compiled some information on “email etiquette” to 
facilitate effective email communication.  The quick desk reference sheets were printed using resources 
available in ELPC.  The reference sheets were reviewed and edited by Ms. Toth before the final copies 
were printed and distributed to all staff. 
 
Anticipated Impacts:   
 
Organization 
Improving email communication will enable ELPC to reach more members of the community in a 
professional way. 
 
Programs 
ELPC staff will be able to focus more on programming at the church since they will spend less time 
communicating with both fellow staff members and the community. 
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Staff 
The staff will have undergone professional development since they will become more knowledgeable 
about and comfortable with the use of email and Microsoft Outlook 2000. 
 
Internal & External Communications 
By learning about effective email usage, the staff will improve their communication with each other and 
with others outside of the church. 
 
Information Management 
Staff members will learn how to use Outlook more effectively, and they will be able to store more 
important information with the program.  Rather than using it strictly for email, they will be able to use it 
for email lists, contact lists, task scheduling, and appointment management.  They will be able to manage 
their personal information more effectively with only one program. 
 
Task 2: The ELPC Website  
ELPC views their existing website as a tool to aid them in the “Reaching Out” portion of their mission 
since it reaches both affiliates of the church as well as outside visitors.  The website content is under the 
supervision of Ms. Toth, although the webmaster, Mr. Johnson, actually maintains the site. 
 
Specific Problems: 

• The website was underutilized as a tool for information collection. 
• Ms. Toth, while an expert in communications, has only recently taken on the responsibility of 

overseeing ELPC’s website. Because she is new to working with this mode of communication, 
she is not yet completely comfortable in discussing many website related issues. 

 
Approach:  Creating online forms 
In this approach, the consultant worked with Ms. Toth and Mr. Johnson to create online forms to allow 
for online registration for events.  Currently, the only registration options available are calling the church 
or submitting a paper form.  Ms. Toth and the consultant worked to evaluate the need (for all church 
departments) for online forms.  They drafted basic forms that can be used to collect general information, 
such as name, address, phone, number, etc., and then Mr. Johnson created the forms.  The forms are set 
up such that the data entered into a form is emailed directly to the person handling registration for any 
given event.  Ms. Toth and the consultant developed a system for keeping the information updated.  They 
also communicated frequently with Mr. Johnson throughout the process in order to gauge feasibility.  See 
Appendix B for an example of one of the forms. 
 
Anticipated Impacts: 
 
Programs 
Attendance and registration will be boosted by posting information about events and allowing online 
registration at the ELPC website. 
 
Staff 
Staff members in charge of event registration will spend less time on the phone since the registration 
process will be streamlined. 
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Technology Planning 
Since the webmaster will maintain the forms, sustainability depends on his employment. 
 
Internal & External Communications 
External communication will be improved since registration will be more streamlined and both staff and 
registrants will not have to spend as much time on the phone. 
 
Information Management 
Information for events is always retained by a specific person and the online forms will always send 
information just to that person.  As a result, duplicate information will not be submitted, and the 
information will always be sent to the proper person.  
 
Task 3: The Hope Academy Webpage 
Hope Academy has one web page on the ELPC site that contains a lot of information. A structure had to 
be created, and more pages added , because it was very difficult to find anything.  Hope believed that a 
redesigned web section on the ELPC site could be used as a tool for collecting information as well as to 
ease administrative burdens.  Hope Academy strives to reach out to the community, and they view the 
website as a tool to aid them in this mission since it reaches current students as well as prospective 
students and teachers. 
 
Specific Problems 

• Layout of information was not optimal. 
• The architectural structure of their section on the website had to be improved. 
• The Hope Academy webpage  was not as inviting and as informative as it could have been for 

visitors. 
 
Approach:  Created an architecture structure for the Hope Academy website 
In this approach, a structure for the Hope section on the website was established.  The consultant worked 
with Ms. Addlespurger to organize it in an efficient and easy to use way.  They analyzed the entire Hope 
Academy organization and chose appropriate sections and headings.  Many revisions were made, but the 
final copy is a very good layout of how the section should be structured.  A meeting was also set up with 
a web designer who confirmed the approach taken and stated that Ms. Addlespurger and the consultant 
went in the right order for creating a new web site – first structure (or architecture) then content, then 
design.   
 
Anticipated Impacts 
 
Organization 
The organization will benefit greatly due to a better section on the website. Many more people can be 
reached with a better design, and more useful information will be included in a more user-friendly design.  
Ms. Addlespurger will save time not having to answer basic questions whose answers could be found on 
the website. 
 
Programs 
This approach will benefit programs at the Academy since more information will be available on the 
website dealing with the programs.  Due to this, information is more easily accessible to those needing it, 
also cutting down phone and email time for Ms. Addlespurger. 
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Technology Planning 
A grant proposal will be created, asking for financial support for a a redesign of the Hope section of the 
ELPC website .  There is a webdesigner who is willing to create the page, but there is no money currently 
to support his work. 
 
Internal & External Communications 
The whole purpose of an improved web presence for Hope is to improve external communications and 
reach more people.  External communications will benefit greatly by this new design. 
 
Information Management 
The critical information that needs to be put on the website is much more organized and consistent with 
this method. 
 
Task 4:  Hope Academy Accounting System  
Hope Academy’s accounting was handled strictly by ELPC’s bookkeeper who utilized the church’s 
accounting system. Because there are some differences between the way Hope and ELPC need to track 
and report their financials, Hope has relied on creating a separate set of records in Excel spreadsheets and 
Microsoft Work.  Ms. Addlespurger and her assistant, Norma Meyer, were using simple methods that 
were very inefficient and error prone.  According to Hope’s mission, the Academy strives to reach out to 
the community, promote the arts, and provide arts education to underprivileged children.  Efficient use of 
resources enables Hope staff to better reach and work with the students and their families.  It was 
anticipated that a good accounting system would benefit Hope Academy. 

Specific Problems 
• It used to take Linda about six hours a week to do payroll.   
• There were many possibilities for error since payroll information was inputted by hand each time. 
• Problems with tracking and accounting for restricted and designated funds. 
• There was no good way of storing information dealing with donors and tracking other revenue. 

 
Approach:  Purchased software and showed Ms. Addlespurger how to use it 
In this approach, the consultant researched various accounting software for non – profit organizations 
(such as QuickBooks) by reading advertisements, going to websites and comparing products and by 
calling various people at the Bayer Center for Non-Profit Management.  Ms. Addlespurger and the 
consultant chose a product that best fit in with Hope Academy’s needs after reviewing the research.  Once 
the software was purchased, the consultant learned how to use it and showed Ms. Addlespurger the 
basics.  The consultant also showed Ms. Addlespurger the two things that she felt were most important – 
payroll and how to keep track of restricted funds.   
 
Anticipated Impacts 
 
Organization 
The Hope Academy will benefit greatly because internal operations will become much more efficient.  
Ms. Addlespurger will save a lot of time and stress dealing with payroll operations as well as keeping 
track of student records and donor information. 
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Programs 
The programs of Hope Academy will not be affected much.  Time will be needed for Ms. Addlespurger 
and Ms. Meyer to become familiar with the program and know how to use it to the best of its capabilities.  
The time allotted for this will take away from time that Ms. Addlespurger would normally contribute to 
the program, but this will be a one time occurrence. 
 
Technical Environment 
Technical equipment will be required for this.  Access will be needed to Ms. Addlespurger’s and Ms. 
Meyer’s computers to install the new software and show them how to use it. 
 
Technology Planning 
Technology planning will be altered a little.  The new software will have to be considered when any new 
plan will be created or modified. 
 
Internal & External Communications 
Internal communications will become more efficient with the use of this new software.  External 
communications will not be affected.  
 
Information Management 
Information management will be helped greatly with a program that helps Ms. Addlespurger and Ms. 
Meyer with accounting.  It will now be easier to access information, manage information, and input 
information.   
 
II.  Outcomes and Recommendations  
 
Analysis of Outcomes  
There were two main projects that were completed at ELPC and two main projects that were completed at 
Hope Academy. 

1. The creation of email quick desk reference sheets for ELPC 
2. The implementation of online registration forms for the ELPC website 
3. The creation of a new structure for the Hope Academy section of the ELPC website 
4. The purchasing and implementation of new accounting software for Hope Academy 

 
Outcome 1:  Creating email quick desk reference sheets for ELPC 
All staff members deal with email on a daily basis since it is heavily used for both internal and external 
communication.  Many staff members are not aware of the capabilities of Microsoft Outlook 2000, the 
program that ELPC currently uses for managing email. 

Results/Outcomes 
• The consultant and Ms. Toth edited existing Microsoft Outlook 2000 tutorials to create a help 

section that is written at an appropriate level for most office staff.   
• The consultant and Ms. Toth included the approved ELPC guidelines for email usage.  
• The consultant and Ms. Toth compiled a document addressing email etiquette and included it 

with the help sheets. 
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Outcome Evidence 
The help sheets (see Appendix C) have been useful to Ms. Toth as they have helped her to improve both 
her interoffice email communication and her email communication with the community.  Though this is 
only one case, it indicates that the help sheets will aid other ELPC office staff. 
 
Evidence of Expanded Capacity 
The ELPC staff members have become more comfortable using their email as a means of communication.  
For example, the church is making an effort to send reports via email, rather than printing them and 
distributing the hard copies.  By addressing email etiquette and email policy, staff members have become 
more educated about and more aware of the impact of email communication.  By improving email usage, 
ELPC staff are better able to fulfill their mission because they are able to focus more on their duties as 
church employees. 

Evidence of Sustainability 
The project is sustainable because ELPC will use Microsoft Outlook 2000 as their email software for the 
foreseeable future.  As a result, the Outlook help section will not become outdated anytime soon.  Email 
etiquette will also be applicable into the future.  The ELPC email usage guidelines will remain the same, 
unless changes are approved by the Session.  Ms. Toth is in possession of electronic and hard copies of 
the help sheets, so she can make any changes necessary in the future. 
 
Recommendation:  Provide technical training for ELPC office staff 
Though the email quick desk reference sheets have aided staff, office employees still need more training 
in order to effectively utilize other commonly used software packages at ELPC.  With the upcoming 
installation of new operating systems and an updated version of Automated Church System (ACS) 
software, training would be beneficial to make the transitions successful.  According to ELPC’s mission, 
the church strives to reach out to the community and promote personal growth.  Efficient use of resources 
enables ELPC staff to better reach and communicate with the community.  Training and providing new 
skills to staff promotes their growth in an increasingly technical society.   

In order to implement staff training, the conversion to the new operating systems and updated versions of 
software (including ACS) should be completed.  Then, the business manager would need to contact local 
technical training centers and the ACS manufacturer about different training options.  The business 
manager could determine which training option is most cost-effective, then obtain appropriate funding 
from the ELPC budget to pay for it. 
 
Resources 
The business manager should visit http://www.carnegielibrary.org/subject/compinternet/edu.html.  This 
website details many technical training options in the Pittsburgh area (including area colleges and 
universities and Carnegie Library programs, as well as other community learning centers).  In order to 
consult the ACS manufacturer about specialized training, she should use the contact information in the 
back of the new ACS help manuals that ELPC already has.  Should the business manager choose to create 
quick desk reference sheets detailing different software applications for ELPC staff, she can consult 
Appendix A for the nine week work plan that required only three hours per week to create the email desk 
reference sheets.  A similar path can be followed to create sheets for other software. 
 
Another useful resource would be other area churches and non-profit organizations.  The business 
manager could see if they have provided staff training and use their recommendations to inform her 
decision. 
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Outcome 2:  Implementing online registration forms for the ELPC website 
ELPC views their existing website as a tool to aid them in the “Reaching Out” portion of their mission 
since it reaches both affiliates of the church as well as outside visitors.  The website content is under the 
supervision of Ms. Toth, although the webmaster, Mr. Johnson, actually maintains the site. 
 
Results/Outcomes 

• Ms. Toth assessed the need for online registration forms by speaking with other staff members.   
• The consultant and Ms. Toth designed general registration forms that could be used for many 

different events.  
• Ms. Toth submitted the plans to Mr. Johnson for implementation. 

 
Outcome Evidence 
While the forms are not yet in use, they will be as soon as a complete list of upcoming events is compiled.  
Many website visitors have already signed up online to receive email updates, so Ms. Toth is confident 
that many visitors will use the online registration forms.  The three staff members who take care of 
registration for most events are excited about using the new forms as a method of collecting information 
online. 
 
Evidence of Expanded Capacity 
Registration is advertised through ELPC publications and on the website, but actual registration had to be 
completed by calling the church office or submitting paper forms.  With the online forms, registration can 
be completed immediately and at any time of day. 

Evidence of Sustainability 
The project is sustainable because ELPC currently pays for the services of Mr. Johnson as webmaster, and 
they plan to retain his services because the website is valued as a successful method of reaching out to the 
community.  Since Mr. Johnson created the forms, he can easily maintain them and keep the forms 
updated. 
 
Outcome 3:  Creating a new structure for the Hope Academy website 
Hope Academy has a lot of information listed on their page of the ELPC website.  The problem lay in the 
fact that all of the information was on one page.  There were no subsections or menus.  In order to find 
information, the user had to scroll down the entire page to find what they needed.  This was not a very 
efficient or user friendly method of posting information.  Therefore, Ms. Addlespurger and the consultant 
created a new structure that would make the Hope section easier to use and understand. 
 
Results/Outcomes 

• An analysis was created of the Academy and what important information should be placed on the 
website.   

• A structure was created which will make using the website easier and provide much more 
information. 

• A meeting was set up with a web designer who confirmed the idea that it is more important to 
have good content and layout of information rather than a fancy design. 

• Ms. Addlespurger is now working on receiving funding so that the new structure can be 
implemented. 

 



 
ELPC / Hope Academy 
Jennifer Cerully / Agata Bugaj, Student Consultants 

Page 10 of 35 
April 30, 2003 

 

Outcome Evidence 
Ms. Addlespurger learned a lot about the set up of websites through this process.  She also was able to 
think of the organization in its entirety, which doesn’t happen on a day to day basis since she’s busy with 
details.  The web designer with whom the consultant and Ms. Addlespurger met, confirmed that the 
structure and architecture of the website was very good and was the first step to creating a very good web 
presence.  Ms. Addlespurger is now planning on hiring a web designer to implement the new website 
design, once appropriate funding is found. 
  
Evidence of Expanded Capacity 
Ms. Addlespurger learned many things about the creation of websites.  She had many ideas as to what she 
wanted on the site, and now has a better idea of how to implement them and where.  For instance, Ms. 
Addlespurger wanted video clips as well as many pictures of students and events, and with the creation of 
the structure and architecture, she was able to see more clearly how everything was going to fit in and 
what was appropriate where. 
  
Evidence of Sustainability 
The project is very sustainable.  The site structure will not change very much in the next few years.  The 
content will be revised to update information on class schedules, events, and new faculty members.  
These are simple changes that can be made by Ms. Addlespurger who is familiar with basic html and web 
page design in FrontPage, which is used by ELPC’s webmaster, Mr. Johnson. Therefore, if Ms 
Addlespurger needs additional assistance, Mr. Johnson would be able to help out 
 
Recommendation: Keep the website as a dynamic communication medium 
This is a national benchmark that should be addressed.  Since a new website design is in the works, and a 
new structure has been established, it is very important to keep the website going and to keep improving 
it.   
 
Updates to the website are crucial since they will make people come back to the website to see what new 
things are happening and to get information on events, news, etc.  New people will also be more likely to 
come back to the site since they will know that the information is fresh and that the organization is very 
active.   
 
A few things can be done to keep the site fresh and lively.  First of all, upcoming, new events should be 
very visible on the front page.  Also, pictures or feedback from previous events could be listed.  Checking 
links to make sure they are still working correctly is important.  New schedules, teacher bios, and alumni 
sections should also reflect the most current and up to date information.  If a class is canceled, the website 
might be a good place to post the information, and it would also cut down on the number of phone calls 
which have to be made. 
 
For a site such as Hope Academy’s, whose layout will not be changed too much throughout the years, it is 
better to have a static page than one that uses the latest technology.  The changes that will be made 
throughout the years (such as class schedules and updates about events) should be done in a simple way.  
Once the website has its new design, it will not be necessary to have the latest database driven, real time 
rendering technology.  The design will be able to withstand many years and it will make the new 
information much more reachable and not as complicated. 
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It is very important to update the website on a timely basis (for instance, every Monday).  By developing 
a routine, it will not only make it easier to make updates, but will also give viewers of the site an idea of 
when new events will be up. 
 
Resources  
The resources include the information which has to be put on the website, as well as simple html to be 
able to implement the changes.  Ms. Addlespurger will be able to do this on her own.  Initially, it may be 
beneficial to have Mr. Johnson show her how to make the updates, but afterwards, she will be able to 
handle it and it will provide her with more flexibility in terms of the Hope Academy website.   
  
Outcome 4:  The purchasing and implementation of new accounting software for Hope 
Academy  
Hope Academy’s accounting was handled strictly by ELPC’s bookkeeper who utilized the church’s 
accounting system. Because there are some differences between the way Hope and ELPC need to track 
and report their financial information, Hope has relied on creating a separate set of records in Excel 
spreadsheets and Microsoft Word. After this task, QuickBooks was installed and implemented at Hope 
Academy in order to track and report its financial information and create check requests that 
automatically balanced the books in the appropriate areas. The check requests are still forwarded to the 
ELPC bookkeeper who handles all of the accounts payable and receivable. The actual money and banking 
will continue to be run through the ELPC system. 
 
Results/Outcomes 

• The consultant and Ms. Addlespurger researched various accounting software, namely 
QuickBooks and FundWare (both by Intuit).   

• Based on information gained from speaking with people in the non-profit organization field as 
well as reading many articles, it was decided that QuickBooks would be an appropriate software 
package for Hope Academy. 

• The consultant installed the software on a computer at ELPC and learned all of the functions that 
Ms. Addlespurger will need for accounting functionality at Hope Academy. 

 
Outcome Evidence 
QuickBooks has much of the functionality that will allow Ms. Addlespurger to do her accounting 
methods in a much more efficient way.  It will allow Ms. Addlespurger to track revenue and create reports 
for designated and restricted funds from donors. These are the two most important functions required.  
Also, Ms. Addlespurger will be able to see how her money is being distributed throughout the Academy 
using simple graphs and charts provided in QuickBooks. 
  
Evidence of Expanded Capacity 
As a result of the installation of QuickBooks, the accounting process is much more efficient.  Ms. 
Addlespurger is able to spend more time concentrating on the program itself, the students, the classes, and 
doesn’t have to worry so much about the time spent doing accounting.  Also, the accounting process is 
much more accurate as the method Ms. Addlespurger was using before was very prone to errors.   
 
Evidence of Sustainability 
This task is very sustainable.  Even though new software comes out every one or two years, the current 
version of QuickBooks will be usable for many years to come.  Although the functionality of upgrades are 
a bit different than those of the current software, the changes are not drastic.  As long as Ms. 
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Addlespurger is able to do what she needs to do with the current software, then she will not have a 
problem for at least a few years, even if bigger and better software packages become available. 
 
Other Recommendations  
 
Recommendation 1: Create an ELPC staff position for a technology specialist 
ELPC is a large organization with many office staff who are continuing to use more and more technology 
on a daily basis.  Creating a technology specialist staff position (either part time or full time) would lessen 
the workload of several staff members, such as the business manager and her assistant, because the 
technology specialist would be the first person to go to with a technology related problem or question.  
The technology specialist could take care of many hardware and software issues in house, and could 
reduce or even eliminate the need for an outside consultant.  The technology specialist, as a paid staff 
person, would be available to handle technology issues more than one day a week, and would be very 
familiar with the ELPC technical environment. 

In order to carry out this recommendation, the creation of a new staff position would have to be approved 
by the appropriate committees.  The hiring process could then begin under the supervision of the business 
manager. 

Resources 
The business manager could write up a job description for the technology specialist position detailing all 
necessary skills that applicants must have.  The following sites provide information on writing an 
effective job description: 
http://www.grandroads.com/howToWriteAJobDescription.htm 
http://www.wetfeet.com/employer/articles/article.asp?aid=370 
http://www.clearlybusiness.com/people_management/rm_write_a_job_description.jsp 
 
These two sites address hiring in the non-profit arena: 
http://www.nonprofitoyster.com/pearlscurrent.cfm 
http://www.nonprofitexpert.com/hiring_key_employees.htm 
 
The business manager could then advertise the position with traditional job searching services, such as 
http://www.monster.com and http://www.careerbuilder.com, as well as sites designed specifically for 
non-profit organizations, such as http://www.idealist.org and http://www.nonprofitcareer.com.  There are 
also sites designed specifically for churches, such as http://churchjobsonline.com and 
http://www.churchstaffing.com.  The position could also be advertised on the ELPC website, in the ELPC 
newsletter, and in local newspaper and magazine classified ads. 

Recommendation 2:  Development of a technology plan for Hope Academy (based on 
suggestion by Khalid El-Arini, Student Consultant) 
Hope Academy is growing every semester.  Even though there are currently only two employees and 
therefore not too much technology, it is important to look into the future.  The Academy does not 
currently have a technology plan.  This should be the next step in terms of technology and how it is used 
in the Academy. 
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Hope Academy should create a technology plan, including at least the following: 
• How the organization currently uses technology 
• What aspects of technology Hope Academy would like to incorporate into the organization in the 

future 
• A budget for implementing the plan 
 

There is a need for the organization to formalize its process of acquiring new technology (both hardware 
and software). The organization should plan ways to integrate technology into its programs.  For instance, 
a media lab or classes on digital art would help Hope Academy grow.  Also, a film class or piano lab 
would allow more students to be a part of the organization, but these projects take time and lots of 
planning.  
 
Currently, it seems that the organization acquires technology based on what is needed at that time. That is, 
as the organization finds itself needing some form of technology, it goes ahead and finds appropriate 
funds and completes the purchase. It would be more beneficial if the organization planned its 
technological improvements, and attempted to predict what it will need in the future. This is especially 
important for financial reasons—specifically the matter of getting funding for technology—since it is far 
more powerful to approach a potential donor with a proposal detailing a specific plan with set goals rather 
than not having a specific plan for the future. 
 
Resources: 
Although there are many resources available on the Internet for helping a non-profit organization, there is 
one that is specifically targeted for non-profit arts organizations.  http://www.oriscus.com/tp/ provides 
many resources for technology usage in non-profit arts organizations.   
 
About the Consultants  
Jennifer Cerully is a junior majoring in Computer Science and Decision Science at Carnegie Mellon.  
After graduating from Carnegie Mellon, Jennifer plans to pursue graduate work in Decision Science. 
 
Agata Bugaj is a junior Computer Science major at Carnegie Mellon with a minor in French. Upon 
graduation from Carnegie Mellon, Agata plans to pursue graduate studies in Computer Science. 
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Appendix A 
 

Nine Week Work Plan Used To Create Quick Desk Reference Sheets for ELPC Office Staff 

Activity How 
long? 

Target  
Completion 

Date 
W1 W2 W3 W4 W5 W6 W7 W8 W9 

Project:  Create quick desk 
reference sheets for ELPC 

office staff 
           

Determine what software is  
commonly used at ELPC 

Part of 
one 

session 
Week 1 X         

Determine specifics about 
tbe software (FAQs, main 

uses, problem areas) 

Part of 
one 

session 
Week 1  

X         

Determine useful shortcuts 
and “tricks” for each 

software package 

Part of 
one 

session 
Week 1 X         

Research existing tutorials 
and reference sheets 

Two 
sessions Week 3   X       

Create user friendly and 
attractive layout 

Part of 
one 

session 
Week 4  

   X      

Create a working draft of the 
quick desk reference sheets 

Two 
sessions Week 5    

 
 
 X     

Have several office staff 
members pilot test the draft 

reference sheets 

One 
week Week 6      X    

Evaluate working drafts 
Part of 

one 
session 

Week 6      X    

Make changes to the drafts 
Part of 

one 
session 

Week 6      X  
   

Create the final quick desk 
reference sheets 

Two 
sessions Week 8        X  

Distribute quick desk 
reference sheets 

One 
week Week 9         X 
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Appendix B 
 

DRAFT 
Form is in Testing Stage 

  Event Registration 

 
      

  

   
Event 1 
Date 
Description 
Link to more info  

Event 2 
Date 
Description 
Link to more info 

Event 3 
Date 
Description 
Link to more info 

Event 4 
Date 
Description 
Link to more info  

 

To register for an event, please provide the following 
information: 

First Name
 

Last Name
 

Organization
 

Street Address
 

Address (cont.)
 

City
 

State/Province
 

Zip/Postal Code
 

Country
 

Daytime Phone
 

E-mail
 

Choose one of the following events. To register for multiple 
events, return to this page and submit another registration: 

Event 1 - MMMM dd, yyyy
 

How many will be attending? 
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Other information (please include names of attendees): 

 

 
If you wish to have a copy of the form, print out this page 
before clicking the "submit" button. 

Please click "submit" only once to allow for processing. A 
confirmation page will appear when form has been properly 
submitted. 

Submit Form Reset Form
 

 

   
Home | Who and Where | Reaching Up | Reaching Out | Reaching You

Site Map  
  

Our congregation seeks to promote peace, justice and human dignity;  
to reflect a spirit of openness, sharing, and learning in our ministry and mission; 
to build a richly diverse faith community that witnesses to our oneness in Christ 
across all boundaries of race, social class, culture, gender and sexual identity.  

(From our Strategic Plan)  

East Liberty Presbyterian Church 
The Cathedral of Hope 

116 South Highland Avenue 
Pittsburgh, PA 15206 USA 

412-441-3800 
412-441-4422 Fax   

Questions? 
Contact the ELPC Webmaster elpcweb@owlweb.org. 
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Appendix C 
Email Quick Desk Reference Sheets  

(Note that the formatting is slightly different than the actual printed manuals) 

Email Desk Reference Table of  Contents 
 
ELPC Email/Voicemail/Internet Usage Policy 
…………………………………………………….. 

A. Guidelines Applicable to Email/Voicemail/Internet Usage 
………………………………... 

Email Etiquette 
…………………………………………………………………………………….. 
Using Outlook 
……………………………………………………………………………………... 
 

I. Email 
…………………………………………………………………………………….. 

A. The Inbox 
………………………………………………………………….. 

B. Receiving and Reading Messages 
…………………………………………... 

C. Creating and Sending an Email Message From Outlook 2000 
……………… 

D. Creating and Sending an Email Message From Another Microsoft 
Office Program (Word, Excel, etc.) 
………………………………………………... 

E. Creating an Email Signature 
………………………………………………... 

F. Creating an Address Book 
………………………………………………….. 

G. Adding Information to the Address Book 
………………………………….. 

H. Building Distribution Lists 
…………………………………………………. 

I. Creating a Distribution List 
………………………………………………… 

J. Organizing Messages Using the Organize Button 
…………………………... 

K. Using the Rules Wizard 
…………………………………………………….. 

L. Creating a Rule 
……………………………………………………………... 

 
II. Searching 

………………………………………………………………………………… 

2
2
3

4-15

4-11
4-5

5
5-6

7
7
8
8
9
9

10
10
11

11

11

12
12
12

13-
14
13
13
14

14-
15
14
14
15
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III. Printing Tips 

……………………………………………………………………………... 
 

IV. Contacts 
………………………………………………………………………………….. 

A. Creating a New Contact 
……………………………………………………. 

B. Helpful Hints For Using Contacts 
………………………………………….. 

 
V. Calendar 

…………………………………………………………………………………. 
A. Setting Calendar Preferences 

……………………………………………….. 
B. Adding Appointments 

……………………………………………………... 
C. Helpful Hints for Using the Calendar 

………………………………………. 
 

VI. Tasks 
……………………………………………………………………………………... 

A. Viewing Tasks 
……………………………………………………………… 

B. Adding a Task 
……………………………………………………………… 

C. Helpful Hints For Managing Tasks 
………………………………………… 

 
VII. Views 

…………………………………………………………………………………….. 
 

VIII. Groups 
…………………………………………………………………………………... 

A. Grouping Items 
……………………………………………………………. 

 

15

15
15
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ELPC E-Mail/Voicemail/Internet Usage Policy 
 
ELPC provides e-mail, voice-mail and Internet access to ELPC employees.  This policy sets forth 
ELPC’s general principles governing e-mail, voice-mail and Internet usage.   
 
The telephonic equipment, computer equipment, software, electronic media and services used to 
supply e-mail, voice-mail and Internet access to ELPC employees are the property of ELPC and are 
intended to be used for ELPC purposes. 
 
Guidelines Applicable To E-Mail ,Voice-Mail and Internet Usage 
• E-mail and voice-mail services are provided for ELPC’s purposes as a means of providing 

services more effectively and efficiently.  While occasional use of these services for personal, 
non-ELPC use is acceptable, ELPC employees and others making use of e-mail and voice-mail 
(termed "employees" for ease of reference only) must demonstrate a sense of responsibility and 
may not abuse e-mail or voice-mail privileges.  

• All communications sent by employees via e-mail or voice-mail must be respectful in tone and 
professional.  E-mail and voice-mail may not be used for transmitting, retrieving or storing any 
communications of a discriminatory or harassing nature, derogatory to an individual or group, 
obscene, or which are of a defamatory or threatening nature.  E-mail should not be used for 
“chain letters” or for any purpose that is illegal, against ELPC policy, contrary to ELPC’s 
interests, or inconsistent with common sense standards of fairness or behavior. 

• ELPC-provided computer equipment and the information stored in such equipment is the 
property of ELPC.  ELPC reserves the right, in its complete discretion, to review any employee’s 
e-mail files, messages, and usage at any time and without advance notice and/or permission. 

• Employees must respect other people’s electronic communications and are not to obtain 
unauthorized access to anyone else’s e-mail or voice-mail messages, except at ELPC’s specific 
direction to investigate compliance with this policy. 

• Employees are not to use e-mail, voice-mail or Internet systems in a way that causes congestion 
on the systems or that significantly interferes with another employee's ability to use the systems. 

• Employees, at all times, must use discretion in communicating confidential or otherwise 
sensitive information and should select communications methods that will protect the 
confidentiality and sensitivity of such information.   

• Employees should keep in mind that any messages or information sent by an employee by e-mail 
or otherwise posted in the World Wide Web are statements that may be identifiable and 
attributable to ELPC, much like a letter sent on ELPC letterhead. E-mail and World Wide Web 
access usage is not confidential.  ELPC retains the option to obtain and otherwise receive 
detailed monthly reports on individual e-mail usage and to use software and any other means to 
track each World Wide Web site visited. 

• Employees are not to send e-mail or voice-mail messages that attempt to hide the identity of the 
sender or someone else or someone from a different entity. 

• Internet services may not be used to participate in Internet discussion groups, bulletin boards or 
other public forums except for pre-approved ELPC purposes, professional education and 
professional development.   

• Employees are to respect all copyrights, intellectual property rights, and otherwise confidential 
information of others’ materials, including those of ELPC, and are not to copy, retrieve, modify 
or forward such materials except as permitted by the owner or as a single copy, for approved 
ELPC reference use only. 
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ELPC employees who violate any guideline are subject to disciplinary action including, without 
limitation, verbal or written warnings, revocation of access privileges, suspension and termination of 
employment. 
 

Note:  These email guidelines are an excerpt from the ELPC staff manual that was drafted in 
February 2002
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Email Etiquette 
• Adhere to all of the guidelines as set forth by ELPC in the email guidelines on page 2. 
• Use the “To” field to send email to people who you are expecting a response from.  Use the 

“CC” (carbon copy) field when you are not expecting a response from a person, but you 
want them to see the message.  Use the “BCC” (blind carbon copy) field when you don’t 
want people to see the list of recipients.  This is useful when you are sending email to many 
people. 

• Always include a meaningful subject line when you send email to help the recipient to easily 
identify and sort email messages.  Only use “URGENT” or “IMPORTANT” if the message 
truly is. 

• Avoid using “reply to all” when responding to email messages unless the response is clearly 
relevant to all recipients. 

• Keep to the point while still maintaining a courteous and respectful tone. 
• Use correct grammar and spelling, and use proper titles when addressing the recipient.  

Email is as important of a form of communication as a letter or memo. 
• Don’t type in all uppercase letters.  While this may be more convenient for you, it is more 

difficult to read. 
• When replying to an email, include relevant portions of the original message.  This helps the 

recipient(s) to remember previous email correspondence. 
• When using a signature (text that is automatically inserted into each email message), adhere 

to the following guidelines: 
• Provide professional contact information since your ELPC email account is primarily 

for work purposes. 
• Keep your signature short. 
• Be cautious when including quotes.  Short quotes that can brighten someone’s day 

are acceptable, but quotes involving politics or other potentially offensive or 
inflammatory topics should be avoided. 

• Be as polite as you would in any face-to-face or telephone conversation – use “please” and 
“thank you”. 

• Do not expect an immediate reply.  Not everyone checks email frequently. 
• Try to reply to emails as soon as is convenient for you. 
• Answer all questions sent to you via email.  Often people skim quickly through long email 

messages and miss questions and leave them unanswered. 
• Do not reply to “spam” or junk email, even if the message claims that you can unsubscribe 

by doing so.  Often the reply is used to confirm that your email address is valid, and 
messages will be sent more frequently. 

• Keep in mind that email is not private, and therefore it should be used in a way consistent 
with ELPC’s standards at all times. 
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Adapted from http://www.cs.queensu.ca/FAQs/email/etiquette.html & 
http://www.emailreplies.com/ 

Using Outlook 
 
The “Using Outlook” section has been adapted from: 
• the Microsoft Outlook 2000 Tutorial found at the Rochester, MN Public Schools website 

(http://www.rochester.k12.mn.us/tutorials/ol2k/ol2khome.htm) 
•  Georgetown University’s “Using Outlook 2000” web page 

(http://www.georgetown.edu/email/outlook-2000/) 
 

I.  Email 
 
Be sure to refer to the ELPC Email Guidelines on page 2 for guidelines applicable to email, 
voicemail, and internet usage. 
 
A.  The Inbox  
When Outlook 2000 receives messages, it stores them in the Inbox folder.  Below is a picture of 
what your Inbox will typically look like and several common symbols you will see when using 
Outlook. 
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Symbol Meaning 

 Message of high importance 

 Message of low importance 

 Message has been read 

 Message has not been read 

 Message has been forwarded 

 Message has been replied to 

 Message has been saved or unsent

 Message has an attachment 
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• The number next to the word "Inbox" in the Folder list tells you how many new messages are 
waiting for you. If there is no number, you have no new messages. 

• When you click the Inbox folder in the Folder list, the contents of the folder are displayed on 
the upper, right portion of the window.  

• The Message header shows the subject and author of the messages in the Inbox. If a message 
header is bold or the envelope icon is closed, that message has not yet been read. If the message 
header is not bold or the envelope icon is open, the message has been read. 

 
B. To receive and read messages 

• Open Outlook 2000 if it is not already open. 
• Any messages sent to you are automatically received to the Inbox folder. If you have new 

messages, an envelope icon appears in the taskbar. 
• In the Folder list, click the Inbox folder. (If it has a number next to it, you have new or unread 

messages.) New and unread messages appear in bold in the Message List pane. 
• To read a new message, click it in the Message List pane. The contents of the message are 

displayed in the Message Contents pane. 
-Or - 
Double-click the message in the Message List pane to open the message in its own window. 

• To open an attachment, double-click its file icon. The attachment opens in the appropriate 
program. 

• When you are finished, you can close the message and it remains in the Inbox folder. 
 
C.  To create and send an email message from Outlook 2000 
There are two ways to send email messages using Outlook 2000: You can either begin a new 
message in Outlook or you can open any Office 2000 program, create a document, and send it 
directly to email from that Office program.  When the message has been sent, it moves to the Sent 
Items folder. If the message cannot be delivered to someone, you usually receive an automatic reply 
letting you know who could not be reached and why. Also, please refer to the Email Etiquette 
section on page 3 for helpful hints on how to communicate your ideas most effectively through 
email. 
 
• Open Outlook 2000 if it is not already open .  
• On the Actions menu, click New Mail Message. Or, on the Standard toolbar, click New 

Mail Message . To send a message on stationery, on the Actions menu, point to New Mail 
Message Using, click More Stationery, and then select a background. The New Message 
window opens.  

• In the To field, type the email address of the person to whom you are sending the message. If 
you are sending to more than one person, type a semicolon (;) between the email addresses. 
- Or - 
Click To to open your address books. Select an address book and double-click a name. The 
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address moves to the To Message Recipients field.  For more information on using address 
books, refer to I.F and I.G. 

• Repeat step 3 to add more email addresses to the To field.  
• To send a carbon copy (CC) to someone (optional), click the CC field. Type the email address in 

the field, or click CC, choose an address from one of your address books, and click OK. Repeat 
to CC other people. 

• To send a blind carbon copy (BCC) to someone (to CC someone without the other message 
recipients knowing the person received the message) (optional), on the View menu select 
BccField. Type the email address in the field, or click BCC, choose an address from one of 
your address books, and click OK. Repeat to blind CC other people.  

• To add a subject line to the message, click in the Subject field and then type a brief line 
regarding the subject of the message.  

• Click in the blank field below the Subject field (the message field) and type your message.  
• To attach a file to your message, perform the following steps: 

• Position the cursor in the message field where you want to insert the file. This can be at 
the beginning, at the end, or anywhere in between.  

• On the Insert menu, click File. Or, click the Insert File button on the Standard 
toolbar. The Insert File dialog box opens.  

• In the Put this entry in the drop down list, click Personal Address Book. Locate the file 
you want to attach. Click the file and then click OK. An icon representing the file labeled 
with the file name appears in the message field. 
-Or- 
Click on a file and drag it to the message field.  

• To insert a signature into an email, click on Insert, then click on Signature.  Note that if you 
have created more than one, you will be given a list to choose from.  For more information on 
creating signatures, see I.E. 

• When you are satisfied with your message, click Send. The message automatically moves to your 
Outbox folder and you return to the main Inbox window.  

• If you are always connected to the network and Internet connection, your message is 
automatically sent.  
- Or - 
If you are not already connected to the Internet, click Send / Receive to connect to the 
Internet and send the message. 

 
 
D.  To create and send an email message from another Microsoft Office 

program (Word, Excel, etc.) 
All Microsoft Office programs integrate email into their core functionality. You can send any 
document as a message or an attached file from directly within an Office program.  
• Open the Microsoft Office program of your choice.  
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• Open an existing document or create a new one and save the document. 
• On the File menu, point to Send to. A submenu appears. 
• On the submenu, you have two choices for sending the document. Select one: 
• To send a copy of this document as the text of the email message, click Mail Recipient. The 

document becomes the body text of a new email message.  
• To send a copy of the document as an attachment to the email message, click Mail Recipient 

(as Attachment).  The document becomes an attachment to a new email message. 
• If you select Mail Recipient, click Send Copy to send the message. 

-Or- 
If you select Mail Recipient (as Attachment), click Send to send the message. 

 
E.  Creating an email signature 
Using a signature file will add information (such as your name, your title, your telephone number, 
quotes, or whatever else you choose) to the bottom of every message you send. 
• Click on Tools, then click on Options. This will bring up the Options window.   
• Click on the Mail Format tab. 
• Click on the Signature Picker button.  This will bring up the Signature Picker window. 
• Click on the New button.  
• Give your signature file a good, descriptive name. 
• Select “start with a blank signature”. 
• Click on the Next button. 
• Type the information you want to include in your signature.  You can click on the Advanced 

Edit button if you want to edit the text in Notepad. 
• You will be shown a preview of your signature. Check the preview to make sure it looks alright, 

then click on the OK button. (If you don't like the way it looks, click on the Edit button.) 
• If you want to include this signature on every email message you send out, make sure its name 

appears beside Use this Signature by default. If you prefer to decide when to use the 
signature, make sure <none> appears beside Use this Signature by default. 

 
 
 
 
 

F.  Creating an address book 
Use the Address Book dialog box to look up email and fax information when you address 
messages. To open the Address Book dialog box, click Address Book on the Standard toolbar, or 
click Address Book on the Tools menu.  There can be several types of address books in the 
Address Book dialog box including the Global Address List, the Personal Address Book, and the 
Outlook Address Book. Select these address books in the Show names from box.  
 
G.  To add information to the address book  
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• Click Address Book on the Standard toolbar. The Address Book dialog box opens.  
• In the Show Names from drop-down box, select Personal Address Book.  

• Click New Entry on the dialog box's toolbar.  
• In the Put this entry in the drop-down list, click Personal Address Book.  
• Select the type of entry you want to create (Microsoft Mail Address, Internet Address, Other 

Address, and so forth) and then click OK.  
• Enter the person's name and email address in the appropriate fields.  
• If you want, click the Business, Phone Numbers, or Notes tabs and enter additional 

information.  
• Click OK to save the information.  
• Repeat steps 3 through 7 to add more addresses.  
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H.  Building distribution lists 
If you frequently email information to the same people, you can build distribution lists. For example, 
you might build a distribution list to everyone on a specific Committee. Then, when you need to 
email something to everyone in the group, you can choose the distribution list name from your 
address book instead of selecting each address separately.  A message sent to this distribution list 
goes to all recipients listed in the distribution list.  Personal distribution lists are identified with and 
are stored by default in the Contacts folder, so you can sort, print, and assign categories to them. 
 
I.  To create a distribution list 
• On the File menu, point to New and then click Distribution List.  
• In the Name box, type a name. The distribution list is saved in your Contacts folder by the 

name you give it.  
• Click Select Members. In Show names from the list, click the address book that contains the 

email addresses you want in your distribution list.  
• In the Type name or select from list box, type the name of a user that you want to include. In 

the list below, select the name, and then click Add. Repeat this step to add the rest of the users 
you want to include in the distribution list, and then click OK.  

• If you want to add a longer description of the distribution list, click the Notes tab and then type 
the text.  

• Click Save and Close.  
• You can easily add or remove names from the distribution list once it is created. To add an 

address that is not in the Contact folder or an address book, click Add New. To remove a 
name, select it and click Remove. 
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J.  To organize messages using the Organize button  
Outlook 2000 can automatically organize certain messages for you. Outlook 2000 can save you time 
sorting through unwanted "junk" messages, highlight messages from certain people, and even move 
specified messages into certain folders upon delivery. 
• Open the Inbox folder. (For some options you will need to have messages in the Inbox.) 
• Click Organize on the Standard toolbar, or, on the Tools menu, click Organize. The Ways to 

Organize Inbox dialog box opens at the top of the message pane. 
• Four options are available on the left side of the dialog box: Using Folders, Using Colors, 

Using Views, and Junk Email. You can do any of the following: 
• Click Using Folders to create new folders, open the Rules Wizard, and move messages 

to other folders. You can easily create a rule to move messages from a certain sender 
into another folder upon delivery.   See I.K and I.L to learn about rules. 

• Click Using Colors to color code messages by sender.  
• Click Using Views to select how you see messages in your Inbox.  
• Click Junk Email to color code junk and adult content messages, or have them sent 

directly to Deleted Items or another folder. You can also add senders to the junk or 
adult content filters. 

• When you are finished, click Organize to close the dialog box.  
 
You can also organize messages that have already been moved to other folders by opening that 
folder and then clicking Organize. 
 
K.  Using the Rules Wizard 
A rule is a set of conditions and actions for processing and organizing your email messages. 
Conditions identify messages for processing, and actions determine what kind of processing is 
performed.  If you receive a large volume of mail from several different groups (personal mail, mail 
from colleagues, junk mail) you can use the Outlook Rules Wizard to create your own rules to 
manage your messages automatically. 
 
Here are some examples of rules you can create:  

• Set up a notification, such as a message or a sound, when important messages arrive.  
• Move messages to a particular folder based on who sent them.  
• Flag messages from a particular person.  
• Assign categories to your sent messages based on their contents.  
• Delay delivery of messages by a specified amount of time.  
• Redirect an email message to a person or distribution list.  
• Automatically reply to a certain type of message with a specific message you create.  
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L.  To create a rule 
• Open Outlook 2000 and click the Inbox folder to display its contents.  
• On the Tools menu, click Rules Wizard. The Rules Wizard dialog box opens.  
• Click New. The Rules Wizard displays a list of the different types of rules you can create along 

with a description of the rule in the Rule description box.  
• Select the type of rule you want to create and click Next.  
• Select the conditions for the rule as directed by the Rules Wizard and then click Next.  
• Specify the action for the rule as directed by the Rules Wizard and then click Next.  
• Specify any exceptions to the rule as directed by the Rules Wizard and then click Next.  
• Specify a name for the rule and then select the Turn on this rule check box to activate it.  
• Click Finish. The rule is added to the Rules Wizard list.  
 
There are three ways to control how rules are applied in the Rules Wizard:  

• When you create a rule, you specify whether the rule is applied when the message arrives in 
the Inbox or when you send a message. You set these options for each rule.  

• After you create multiple rules, you can move the rules up or down in the list in the Rules 
Wizard to change the order in which they are applied. Rules are applied in the order they 
appear in the list. Rules that are marked "client only" are applied after all other rules.  

• You can specify whether the rule runs automatically or manually. This is useful when you 
want to apply rules manually to messages already delivered to the Inbox.  

 

II.  Searching  
• To quickly search for items in the current folder and its subfolders, click Find on the Standard 

toolbar and enter a keyword.  
• To search for items in multiple folders or to search for items by more than one criterion, click 

Find on the Standard toolbar and then click Advanced Find and specify the search criteria.  
 

III.  Printing Tips For Outlook 2000 
• For most items you need to select a Print Style. For example, you can print your daily, weekly, or 

monthly calendar, or print calendar details.  
• You need to also select a print range.  
• You can also print some views. You can change what is printed in a view by changing the look 

of the view or by modifying the print style, which controls how the page and paper, fonts, and 
other formatting options are set up. A view that is based on the timeline or icon view type 
cannot be printed.  See VII for more information on views. 
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IV.  Contacts 
You can use Outlook to maintain an electronic address book of your friends, colleagues, and anyone 
else you need to contact.  In the Contacts folder, you can store a wide range of information about 
people, from their phone numbers and physical addresses to email addresses and Web addresses, if 
they have them. You can link any Outlook item or Microsoft Office document to a contact to help 
you track activities associated with that person or group. 
 
A.  To create a new contact 
• On the File menu, point to New and then click Contact. The Contact dialog box opens. 
• In the Full Name box, type a name for the contact. Enter the information you want to include 

for the contact. There are several tabs on which you can enter information.  
• If you wish, assign the contact to a category. Click Categories and then select a category from 

the list.  
• Click Save and Close.  
 
B.  Helpful hints for using contacts 
• To create a contact from an email message you receive, right-click the name in the From field 

that you want to make into a contact, and then click Add to Contacts 
• You can look up information about a contact from an email message, a meeting request, and a 

task. Simply right-click the contact name and then click Look up Contact.  
• Click the letter tab at the right of the screen to display contacts that begin with that letter.  
• When you enter a name or address for a contact, Outlook 2000 separates the name or address 

into parts and puts each part in a separate field. You can sort, group, or filter contacts by any 
part of the name or any part of the address you want.  

• You can file contact information under a last name, first name, company name, nickname, or 
any word that helps you find the contact quickly, for example, "Office Staff" for all ELPC office 
staff.   

• You can enter up to three addresses for each contact. You may want to designate one address as 
the mailing address and use it for mailing labels, envelopes, or creating mail-merge letters. 
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V.  Calendar 
 
A.  Set Calendar preferences 
• With the Calendar folder open, on the Tools menu, click Options. The Options dialog box 

opens.  
• Click the Preferences tab.  
• Under Calendar, select Default reminder to have Outlook 2000 remind you automatically of 

all appointments. Then, in the drop-down box, select the amount of time before appointments 
you want to receive the reminder. (You can change this time for individual appointments when 
you create them.)  

• Click Calendar Options. The Calendar Options dialog box opens.  
• Select the days of the week you want to show on your calendar.  
• Select other options as necessary. To select a time zone, or show more than one time zone at a 

time, click Time Zone.  
• To have Outlook 2000 automatically display holidays for different countries or religions, click 

Add Holidays.  
• When you are finished, click OK. 
 
B.  Adding appointments 
When you schedule an appointment, you have several options for it, such as setting the appointment 
to be recurring (for events like regular meetings) or having Outlook 2000 remind you about an 
appointment before it occurs.  
• Click the Calendar folder to open it. You should see the one-day view for the current day.  
• Click a date in the mini month calendar to the right of the Daily view calendar.  
• Click anywhere in the time box where the appointment will begin. The box turns blue.  
• Double-click the selected box. The Appointment dialog box opens.  
• In the Subject box, type text describing the appointment, such as "Student Conference."  
• In the Location box, type the location for the appointment.  
• In the Start time and End time boxes, adjust the length of the appointment, if necessary.  
• To have Outlook 2000 remind you of this appointment before it occurs, select Reminder and 

then select when you want the reminder to occur from the list.  
• To set the appointment as a recurring meeting, click Recurrence (at the top of the window), set 

the appropriate options, and then click OK.  
• Click Save and Close. You return to the Calendar folder's main window. Notice that the date 

on which you made the appointment now appears bolded in the mini month calendar.  
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C.  Helpful Hints for Using the Calendar 
• When you select start and end times for an appointment, you can take advantage of Autodate 

functionality and type text such as "next Tuesday" or "noon" instead of typing an exact date or 
time. 

• In Calendar, you can also create an appointment by selecting a block of time, right-clicking, and 
then clicking New Appointment.  

• In the Calendar folder, on the View menu, point to Current View. A submenu appears. On the 
submenu are several options for viewing your appointments. Select one of the following: 
Day/Week/Month, Day/Week/Month View with AutoPreview, Active Appointments, Events, 
Annual Events, Recurring  

 
VI.  Tasks 
A task is a personal or work-related errand you want to track through completion.  

• A task can occur once or repeatedly (a recurring task).  
• A recurring task can repeat at regular intervals or repeat based on the date you mark the task 

complete. For example, you might want to send email updates to several staff members on 
the last Friday of every month.  

Like everyone else, you probably have ongoing tasks that need to be completed. For example, you 
may promise your Committee chairperson that you will have a report completed by a certain date or 
by next week you will have contacted people about a certain event. Using the Task list, you can keep 
track of all of these tasks and their due dates and view them regularly in your Task folder or the 
Calendar. Organizing tasks electronically allows you to keep them all in one place and keep them in 
mind so nothing falls through the cracks. 
 
A.  To view tasks 
You can view tasks in one of two ways:  

• Open the Tasks folder. You can rearrange the view of the tasks in several ways. To do so, on 
the View menu, point to Current View and then select a view option from the submenu.  

• Open the Calendar folder. A list of your tasks appears in the lower right portion of the 
window.  

 
B.  To add a task 
• Click the Tasks folder to open it.  

• Click New Task . The New Task dialog box opens.  
• In the Subject box, type a description for the task.  
• In the Due Date box, type a due date (optional). You can also select a due date by clicking the 

arrow next to the box and selecting a date on the mini month calendar.  
• To receive a reminder about this task before the task is due, select Reminder.  
• Select a status, priority, and percentage complete for the task.  
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• To assign the task to a category, click Categories and select a category from the list.  
• Click Save and Close.  
 
C.  Helpful Hints For Managing Tasks 
• Click a column heading to sort tasks by the column  
• To change task information, click the appropriate task and type the new information. 
• You can also right-click on a task in the Calendar folder to change its status, move it, delete it, 

and more.  
• You can also add tasks to your list from the Calendar folder.  

 

VII.  Views 
Views give you different ways to look at information in a folder by putting it in different 
arrangements and formats. A view is composed of a view type, fields, a sort order, colors, fonts, and 
many other settings. You can also use views to control the amount of detail that appears for items 
and files to help you emphasize or analyze details. For example, by viewing email messages by 
conversation topic, you can easily separate personal messages from messages related to an ELPC 
event.  
 
Each folder in Outlook 2000 has a set of standard views. You can change the way you look at items 
or files by changing the standard views for each folder (on the View menu, point to Current View, 
and then click the view you want, or select it from the drop-down list on the Advanced toolbar). 

 

VIII.  Groups 
A group is a set of items with something in common, such as email messages from the same sender 
or tasks with the same due date.  Group items to see related items together, similar to an outline. For 
example, group items by priority to separate high-priority items from low-priority items. You can 
expand or collapse the group headings to display or hide the items they contain.  You can only 
group items that are in a view based on a table or a timeline view type. When you group items by a 
field that can contain more than one entry, items may appear more than once in the table or 
timeline. Though you see the item more than once, it exists as only one item. Any changes you make 
to one instance of the item are stored with all instances of the item. 
 
A.  To group items 
• On the View menu, point to Current View and then click a view that displays items in a table 

or a timeline view type.  
• On the View menu, point to Current View and then click Customize Current View.  
• Click Group By.  
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• In the Group items by box, select a field to group by.  
• If the field you want isn't in the Group items by box, select a different field set in the Select 

available fields from box.  
• Click Ascending or Descending for the sort order of the group headings. 
• To display the field you're grouping items by, select the Show field in view check box. 
• To group by subgroups, click a field in the Then by box. 
 

 

 
 


